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IBM Infoprint Manager for Windows Version 2.1.0 README

This readme contains the following information:

“General Release Notes for Infoprint Manager for Windows”| contains topics that

apply to Infoprint Manager for Windows in general. When this information

changes, it will be marked with revision bars ( | ) in the left margin.

“Release Notes for Version 2.1.0 PTF UR54364 (July 2004)” on page 2| contains

topics that apply to this Version 2 Release 1 service update.

* [“Release Notes for Version 2.1.0 PTF UR54088 (December 2003)” on page 10|

contains topics that apply to this Version 2 Release 1 service update.

“Release notes for Version 2.1.0 PTF UR53923 (April 2003)” on page 12| contains

topics that apply to this Version 2 Release 1 service update.

+ |“Release notes for Version 2.1.0 PTF UR53740 (November 2002)” on page 13|
contains topics that apply to this Version 2 Release 1 service update.

+ [“Release notes for Version 2.1.0 PTF UR53705 (August 2002)” on page 15

contains topics that apply to this Version 2 Release 1 service update.

* [“Release notes for the Version 2.1 NLV Refresh” on page 15| contains release
notes that apply to the Version 2 Release 1 National Language Version (NLV)
code.

+ |“Release notes for Version 2.1” on page 15| contains release notes that apply to
the Version 2 Release 1 code.

General Release Notes for Infoprint Manager for Windows

Information on the following topics was removed from this README because it is
now available in the Infoprint Manager for Windows: Getting Started manual.

* Server software prerequisites

+ Installing and uninstalling Infoprint® Manager for Windows service updates
* Before and after migrating to Infoprint Manager Version 2.1

* Migrating optional features

Note: “Customizing error logs in the Infoprint Manager server” has been added to
the IBM Infoprint Manager: Update Guide for PTF U483536 and PTF UR54088.

Backing up the Userlnit file for the PostScript transform
program

If you have modified the Userlnit file for the ps2afp transform, you must create a
backup copy of the file prior to installing a service update or new version of
Infoprint Manager for Windows. If you do not perform this task, the install
program provided with Infoprint Manager for Windows overwrites the existing
Userlnit file, removing all prior changes to that file.

Infoprint Manager for Windows installs the UserInit file into the following
locations:

1. install_path\var\psf\ps2afp
2. install_path\var\psf\ps2afp2

© Copyright IBM Corp. 2003, 2004 1
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Possible issues when completing Infoprint Manager for
Windows Server 2.1.0 install

When installing the Infoprint Manager for Windows server CD-ROM, you might
receive the Wrong Volume pop-up error message:

The wrong volume is in the drive. Please insert volume IPM 410A NTS1
into drive D:

where D: is the CD-ROM drive on your Windows server.

If this occurs, follow the directions and reinsert the base server CD-ROM to
complete the install successfully.

Accessing the Publications CD-ROM

Use the following procedure to access the publications CD-ROM:

1. Insert the Publications CD-ROM in your CD-ROM drive. It starts automatically.

2. From the pulldowns for all choices, select Open the collection index.

3. Click OK.

4. Because this change does not take effect until you re-insert the CD-ROM, open
the CD-ROM drive and then close it.

5. The CD-ROM now opens to the opening page of the publications in pdf
format.

6. Scroll down the list of publications, and select the one you want to view.

Viewing the Publications CD-ROM

The contents of the publications CD are best viewed using Netscape Navigator
Version 4.7 or higher, or Internet Explorer Version 5.0 or higher. Adobe Acrobat
Reader Version 3.0 can be used to view most PDF files on the CD; however, for
larger files, such as the Infoprint Manager: Reference, Acrobat Reader Version 4.0
or higher is required. To download Acrobat Reader, visit the Adobe web site at

http:/ /www.adobe.com

| Release Notes for Version 2.1.0 PTF UR54364 (July 2004)

2

PTF UR54364 (APAR IR52780) contains several enhancements to function, usability,
and reliability. Refer to the “Functional Enhancements” section for more
information. For a summary of the fixes provided with this PTF, refer to the
Service Page of the Infoprint Manager for Windows 2.1 Web site at

http:/ /www.printers.ibm.com/R5PSC.NSF/Web /ipw210ser

To apply this service update, refer to the Infoprint Manager for Windows: Getting
Started manual.

Windows error messages when installing Infoprint Manager

When you install the base Infoprint Manager product on the supported Windows
operating systems, Windows may issue error messages depending on which
service pack level you have installed. Ignore these Windows error messages,
continue with the base installation, and then install PTF UR54364 (APAR IR52780)
because it resolves the errors.

Infoprint Manager for Windows README
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MVS download receivers cannot exceed 50

The maximum number of MVS download receivers is 50. If you try to create more
than 50 MVS download receivers, Infoprint Manager issues the following error
message: Creating more than 50 MVS Download receivers is not permitted.

New Ipdmap.txt file included with PTF UR54364

The July 2004 PTF includes a new lpdmap.txt file that is installed in
install_path\var\pd\lpd. Before the new file is installed, Infoprint Manager makes
a backup copy of the existing Ipdmap.txt file. If you have modified your version of
the Ipdmap.txt file, you must merge the changes from the backup copy into the
new lpdmap.txt file.

Viewing national characters in a DOS window for French,
German, ltalian, or Spanish servers

If you use DOS windows to communicate with a French, German, Italian, or

Spanish server, follow this procedure to view the national characters correctly:

1. Set the font for the command prompt window to Lucida Console. Click on the
icon in the upper left corner and select Properties —> Font.

2. In the Font field, select Lucida Console, and click OK. A pop-up window
displays that allows you to select whether to apply the selection to this window
only or to all windows ("Modiy shortcut that started this window”).

3. Select Modify shortcut, and then click OK. You should only have to do this
once.

4. Enter chcp 1252 on the command line. You must do this in every DOS window
that you use to communicate with the server.

Clarification about accounting exits

Updated Information
This topic will be added to the following publications in the Infoprint
Manager Library:

Infoprint Manager for Windows: Procedures, G544-5814

Chapter 17, "Gathering accounting and auditing data about print jobs”

The PSF accounting user exit enhancements that were included as part of the
Infoprint Manager for Windows Version 2.1 release require clarification. A new
procedure has been added to the Infoprint Manager Administration GUI to show
you how to activate the default PSF ainuxjobcompletion accounting logs. The
ainuxjobcompletion accounting exit interface can be used for PSF-driven IPDS
printers. It provides actual (versus projected) accounting data and provides
additional information about completed print jobs.

Customers who migrate from an existing Infoprint Manager Version, such as 1.1, to
Infoprint Manager V2.1 will continue to find the previous accounting exit interface
intact. Accounting programs that count on the previous accounting interface, which
includes the IBM supplied samples, will function without modification.

Customers installing a Infoprint Manager V2.1 server for the first time will see the

post-print accounting exit activated and the accounting data will be written to
install _path\var\psf\jobcompletion.log.

Infoprint Manager for Windows README 3
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The intent is to minimize migration issues for existing customers, but to start new
customers out with the preferred accounting exit. The default installation for new
machines will not activate both accounting exits. However, when V2.1 is installed,
both new and migrated customers can choose to have the old, preferred, or both
accounting exits active.

If a migrating installation wants to activate the preferred (new) exit, the
administrator must set the psf-post-print-accounting-program-name auxiliary
sheet attribute in the appropriate auxiliary sheet object to provide the name of
either the IBM supplied sample exit or a custom version of the preferred exit. The
administrator may also choose to deactivate the old exit by resetting the value of
the psf-exit-program-name auxiliary attribute in the appropriate auxiliary sheet
object to <not set>.

If a new installation wants to deactivate the preferred exit and instead run the old
exit, the administrator must reset the psf-post-print-accounting-program-name
auxiliary sheet attribute in the appropriate auxiliary sheet object to <not set>. The
administrator may also choose to activate the old exit by setting the value of the
psf-post-print-accounting-program-name auxiliary sheet attribute in the
appropriate sheet object to the name of either the IBM supplied sample exit or a
custom version of the old exit.

In both cases, the administrator may also choose to have both exits active by
setting the psf-exit-program-name and the psf-post-print-accounting-program-
name auxiliary sheet attributes to the names of the two accounting programs (old
and preferred). The administrator may also choose to deactivate both exits by
leaving both attributes unset.

Accounting reports provide structured information

When you collect accounting data, you can review it in raw format in the
accounting logs, or you can use the Infoprint Manager utilities for accounting
reports to format the information into a more readable format. The three
accounting report utilities that were added to support the preferred job completion
accounting are described in the Infoprint Manager: Reference in "Chapter 2, Infoprint
Manager Tools.” Here is a list of the job completion accounting report utilities:

ainurpt? Generates job completion information for an actual destination. The
following is a sample report from the ainurpt? utility:

Binl Binl Binl Binl Bin2 Bin2 Bin2 Bin2
User User Job Job User User Job Job User User Job Job
Destination Jobs  Pages Sheets Pages Sheets Pages Sheets Pages Sheets Pages Sheets Pages Sheets
vpad 16 56 34 78 56 56 34 78 56 0 0 0 0
4317ad 16 24 20 40 36 24 20 40 36 0 0 0 0
ainurpt8 Generations post-print accounting data by job submitter. The
following is a sample report from the ainurpt8 utility:
Binl Binl Binl Binl Bin2 Bin2 Bin2 Bin2
User User Job Job User User Job Job User User Job Job
User 1D Jobs  Pages Sheets Pages Sheets Pages Sheets Pages Sheets Pages Sheets Pages Sheets
joeuser 32 80 54 118 92 80 54 118 92 0 0

4
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ainurpt9 Generates detailed entries of times and pages printed. The
following is a sample report from the ainurpt9 utility:

Please enter the userid (up to 8 chars) : joeuser

Report for joeuser

Start Start Printer Pages Sheets Job

Date Time ID Printed Printed Name
0 0 vpad 2 2 05/04/2004 07:26:25 3784100002 0 tiger.ps
0 0 vpad 2 2
0 0 vpad 2 2 05/04/2004 07:27:57 3784100003 0 tiger.ps

Using the ’'no resident’ version of the sample grid files

— Updated Information
This topic will be added to the following publication in the Infoprint
Manager Library:

Infoprint Manager for Windows: Procedures, G544-5814

Chapter 23, "Working with fonts and global resource identifiers” under
"Preventing Infoprint from using GRID files”

There may be situations when you do not want Infoprint Manager to use
printer-resident fonts.

If you do not have customized GRID files and want to use the 'no resident” version
of the sample grid files shipped with Infoprint Manager, complete the following
procedure:

1. From a DOS prompt:
cd <install path>\var\psf\PrinterName

Where PrinterName is the name of the Infoprint physical printer that represents
the actual printer device.

2. Create the charset.grd file from the charset.grd.nores file:
copy <install path>\1pp\psf\grd\charset.grd.nores charset.grd

3. Create the codepage.grd file from the codepage.grd.nores file:
copy <install path>\1pp\psf\grd\codepage.grd.nores codepage.grd

Infoprint Manager documentation updates

With this service update, this README and the Infoprint Manager: Reference,
S5544-5475-14, have been revised.

In addition to revisions for the functional enhancements in the July 2004 PTF, the

following changes were made to the Infoprint Manager: Reference:

* To ensure accessibility when viewing the syntax diagrams in the Infoprint
Manager: Reference online, the syntax diagrams have been converted to graphic
notation, which is also referred to as railroad track diagrams. The original syntax
diagrams are preserved in an appendix entitled "Original syntax diagrams.”

Infoprint Manager for Windows README 5
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* "Appendix E: Dictionary of translated Keywords” is included as part of the
Infoprint Manager: Reference for customers who use the command line in other
than English. Attributes and values are shown in English to French, English to
German, English to Italian, and English to Spanish translations.

Functional enhancements

The following enhancements in function and usability are available with the July
2004 Infoprint Manager for Windows PTF.

Windows Server 2003 Standard operating system supported
Infoprint Manager for Windows now supports Windows Server 2003 Standard
operating system.

Support for new printers with Infoprint Manager
¢ Infoprint 1334

* Infoprint Color 1354L

* Infoprint 1410 MFP

* Infoprint 1412

Support formsize specification

The July 2004 PTF includes support that allows operators and end users for IPDS
continuous forms printers that support the IPDS XO0H SMS command (such as the
IBM 6400 Printer with IPDS coax feature V3R3 or higher) to specify a job medium
extent (form length), rather than having to make the change at the hardware
printer console. This function enables MVS Download jobs to honor the FORMLEN
JCL parameter with 6400 printers. This support includes the following:

* The form-length document/default document attribute has been added.

* The form-length-range-supported actual destination and logical destination
attributes have been added.

For more information on form-length and form-length-range-supported, see
Infoprint Manager: Reference.

Note: The formsize specification support must be used with PSF for z/OS APAR
OA07109.

The sap2afp transform includes Simplified Chinese and
Traditional Chinese language support and SAPGOF data
generated from SAP SmartForms support

The July 2004 PTF adds Simplified Chinese and Traditional Chinese support to the
sap2afp transform.

With OTF jobs, code page support is flexible because OTF jobs use specific fonts.
When an OTF job calls for a font, the sap2afp transform compares the specified
font name and point size in the OTF job with entries in the fonts.tab table, and if
a match is found, a new AFP character set and AFP code page are selected.

When the sap2afp transform processes an ABAP job, the defcp.tab table is loaded
to map single-byte ASCII to EBCDIC codepoints. sap2afp calls the iconv utility for
double-byte codepoint matching. sap2afp processes the pagedef.tab file and
matches the value for the PJPAPER parameter in the ABAP file to an entry in the
pagedef.tab to determine which character sets to use in normal and bold mode.
Therefore, all the ABAP jobs sent to a given Infoprint Manager server use the same
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codepage with different character sets possible depending on the value selected
with the PJPAPER parameter in the ABAP print job.

Enabling multi-byte character sets for Simplified Chinese Fonts on Windows:
The sap2afp transform supports the use of double-byte character sets (DBCS)
through the use of the iconv utility on Windows. To use this support, you must
run the SAPGOF (or a compatible) device type on an SAP R/3 system at Release
4.0A or higher.

To enable this support, an Infoprint Manager Windows administrator must
perform the following procedure:
1. Obtain and install the selected Simplified Chinese AFP fonts required for
printing.
2. Ensure that the iconv utility is installed on the Infoprint Manager system where
the sap2afp transform is running.
3. Create a backup copy of the current \install_path\sap2afp\defcp.tab file.
4. Copy the \install_path\sap2afp\defcp.tab.spchinese file to the
\install path\sap2afp\defcp.tab file.
5. Create a backup copy of the current \install_path\sap2afp\pagedef.tab file.
6. Copy the \install_path\sap2afp\pagedef.tab.spchinese file to the
\install path\sap2afp\pagedef.tab file.

Note: When you have completed this procedure to enable multi-byte character
sets, you may choose to modify the pagedef.tab or fonts.tab to specify a
different set of fonts.

Enabling multi-byte character sets for Traditional Chinese Fonts on Windows:
The sap2afp transform supports the use of double-byte character sets (DBCS)
through the use of the iconv utility on Windows. To use this support, you must
run the SAPGOF (or a compatible) device type on an SAP R/3 system at Release
4.0A or higher.

To enable this support, an Infoprint Manager Windows administrator must
perform the following procedure:
1. Obtain and install the selected Traditional Chinese AFP fonts required for
printing.
2. Ensure that the iconv utility is installed on the Infoprint Manager system where
the sap2afp transform is running.
3. Create a backup copy of the current \install_path\sap2afp\defcp.tab file.
4. Copy the \install_path\sap2afp\defcp.tab.tdpchinese file to the
\install path\sap2afp\defcp.tab file.
5. Create a backup copy of the current \install_path\sap2afp\pagedef.tab file.
6. Copy the \install_path\sap2afp\pagedef.tab.tdchinese file to the
\install path\sap2afp\pagedef.tab file.

Note: When you have completed this procedure to enable multi-byte character
sets, you may choose to modify the pagedef.tab or fonts.tab to specify a
different set of fonts.

The July 2004 PTF also updates the sap2afp transform to support SAPGOF data
generated from SAP SmartForms.

Line data using OpenType fonts now supports using the Byte
Order Mark (BOM) and little endian data

With the July 2004 PTE, Infoprint Manager can process the Unicode Byte Order
Mark (BOM) when printing line data with OpenType fonts. (For UTE8 or

Infoprint Manager for Windows README 7
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UTF16-BE data, the BOM is skipped and not printed. For UTF16-LE, the data is
reversed to BE before it is printed, and the BOM is not printed.) In addition,
Infoprint Manager can now recognize multi-byte carriage return and line feed
characters when parsing Unicode line data.

This support allows you to process UTF8 and UTF16 line data in either
little-endian or big-endian order using a traditional line data or record-format page
definition. As many Windows and AIX editors default to UTF8 or UTF16LE
encodings and automatically insert a BOM at the beginning of the file, you can
now print documents created with these editors using Unicode-enabled Open Type
Fonts.

Mixed mode data is line data mixed with MODCA structured fields. You can use
mixed mode data with UTF8, UTF16LE, and UTF16BE with a BOM as long as the
BOM is the first bytes (following any cc or trc bytes) of the first line of data.

If you want to mix UTF8 or UTF16BE data with other data encodings, you can do
that if there is no BOM. In this case, the font selected for the data tells Infoprint
Manager the data encoding. You can’t do this with UTF16LE data because it
always requires a BOM.

This new support includes a -o newlineencoding flag for the -o flag, a
stream,(newline=characters,encoding) value for the fileformat parameter on the
line2afp transform, and a new-line-option-data-encoding document/default
document attribute. For more information on this new support, see Infoprint
Manager: Reference.

Print-on-Demand feature now available with Infoprint Manager for
Windows

The July 2004 PTF supports the optional Print-on-Demand feature for Infoprint
Manager for Windows with a subset of the functions available with the Infoprint
Manager for AIX Print-on-Demand feature. The subset includes Submits, Save
Pages, support for file-sharing between the AIX and Windows platforms, and
support for color mapping tables.

Installing the Print-on-Demand Feature: After installing Infoprint Manager on
your server with the July 2004 PTF, insert the Infoprint Manager for Windows
Print-on-Demand Feature CD into the CD-ROM drive. The install program on the
CD will start automatically; follow the instructions to complete the installation.

Note: You can put the Print-on-Demand Submit Clients on a different machine
than the one that contains the Infoprint Manager Server.

Submit Clients with Print-on-Demand Feature: The Print-on-Demand feature
contains the following three Submit clients:

* IBM Infoprint Submit Express for the Windows Operating System
* IBM Infoprint Submit for the Windows Operating System
e IBM Infoprint Submit for the Macintosh Operating System

If you are a new Windows user of the Print-on-Demand feature, we recommend
that you use the Submit Express client. For more information about Submit Express
for windows, see Infoprint Manager Print-on-Demand Feature: Submit Express for
Windows User’s Guide.
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If you are a current Infoprint Manager for AIX user of the Print-on-Demand
feature, you may continue to use Infoprint Submit for Windows. For more
information about Submit for Windows, see Infoprint Manager Print-on-Demand
Feature: Submit for Windows User’s Guide.

If you work in the Macintosh environment, you may use the Macintosh client. For
more information about Infoprint Submit for Macintosh, see Infoprint Manager
Print-on-Demand Feature: Submit for Macintosh User’s Guide.

Sample MVS Download exit program enhanced

Two additional parameters or arguments have been added to the sample exit
program. Here is a description of the parameters describing the new parameters as
well as the existing parameters (#1 through #5):

Parameters Definition

#1 Name of the file that contains data received
from the MVS JES spool

#2 MVS JES destination control parameters

#3 Infoprint target destination (printer) where
the job is submitted

#4 MVS Download receiver name

#5 Infoprint print parameters

#6 Port

#7 Exit parameters

Changes to the MVS Download host receiver worksheet: The following changes
were made to the MVS Download host receiver worksheet as part of the MVS
Download Exit Program enhancements:

Table 1. MVS Download host receiver worksheet

Management Console Description Value
Prompt
Port Number The port assigned for

communication with z/OS
or. This value must be the
same as the port assigned
during configuration of the
host system.

Target Destination Name The Infoprint Manager
logical destination to which
jobs are routed from this
receiver by default. This
default may be overridden
with the appropriate z/OS or
job parameters and printer
control file settings. In
sample destination control
file supplied with Infoprint
Manager, the value of
keyword DEST overrides
whatever value you specify
here.

Note: This name is
case-sensitive.

Infoprint Manager for Windows README 9
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Management Console
Prompt

Description

Value

Print Control File

The file that contains the
appropriate attributes for
jobs submitted to this
receiver. You may use the
default file, or you may
point to a customized
version of this default file.

Exit Program Name

The program that processes
jobs submitted to this
receiver from the host and
passes the jobs to the
requested Infoprint Manager
destination. Typically, the
default program
0390dsubm.exe is used.

Additional Exit Program
Parameters

For the exits supplied with
the Infoprint Manager base
product, no values should be
entered.

If you are using custom exits,
consult with the person
responsible for the custom
exits to determine what to
enter here.

Retain command files

Indicate whether to save the
command files for jobs that
do not print correctly.

__yes__no

Process one file at a time

Indicate whether Infoprint
Manager should wait for a
previous job to complete
before starting to process the
next job.

__yes _

no

Changes to the Infoprint Manager Management Console: The following changes

have been made to the Infoprint Manager Management Console:

e The Additional Exit Program Parameters entry field has been added to the Add
MYVS Receiver dialog. Use this new entry field to list the new parameters that
you want to include in the Exit program.

* The Exit Program Parameters entry field has been added to the View MVS
Download Receiver dialog. This new entry field lists the additional exit
program parameters. You cannot edit this field.

Release Notes for Version 2.1.0 PTF UR54088 (December 2003)

PTF UR54088 (APAR IR51331) contains several enhancements to function, usability,
and reliability. Refer to the “Functional Enhancements” section for more
information. For a summary of the fixes provided with this PTF, refer to the
Service Page of the Infoprint Manager for Windows 2.1 Web site at

http:/ /www.printers.ibm.com /R5PSC.NSF/Web /ipw210ser
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To apply this service update, refer to the Infoprint Manager for Windows: Getting
Started manual.

Infoprint Manager documentation updates
With this service update, you will notice the following changes:

The IBM Infoprint Manager: Update Guide for PTF U483536 and PTF UR54088
contains information describing fixes and product enhancements available with
these service updates for both Infoprint Manager for AIX® Version 4 Release 1
and Infoprint Manager for Windows Version 2 Release 1.

Note: Earlier versions of some information are published in the currently
available Infoprint Manager library manuals.

The Infoprint Manager: SAP R/3 Planning and Configuration Guide, (5544-5902) has

been updated and has a publication number.

Functional enhancements

The following enhancements in function and usability are available with the
December 2003 Infoprint Manager for Windows PTF:

Support for printing with Microsoft Unicode Open Type Fonts through Infoprint
Manager.

Support through the img2afp transform for printing FS45 Image Object Content
Architecture (IOCA) images as high-quality FS10 IOCA images on
black-and-white printers.

Support for an IBM® Infoprint Manager Linux client to enable users of Linux on
intel-based servers to issue Infoprint commands over a TCP/IP-connected
network to an Infoprint Manager Windows server.

Support for using the following new printers with Infoprint Manager:
- Infoprint 1222

— Infoprint 1226

- Infoprint 1312

- Infoprint 1232

— Infoprint 1352

— Infoprint Color 1354

— Infoprint Color 1357

— Infoprint 1372

— Infoprint 2060ES, Infoprint 2075ES, Infoprint 2090ES, and Infoprint 2105ES are
new Workgroup printers that provide significant finishing options, such as a
booklet-maker, a post-fuser insertion, and the ability to print to a document
server (DASD).

The number of Distributed Print Function (DPF) host receivers that can exist at
one time has been increased to 100.

Five new PPD files have been added to Infoprint Select in order to allow you to
specify Infoprint attributes for finishing when printing to the following printers
as either TCP/IP or Channel DSSs:

— IBM Infoprint 4100

— IBM Infoprint 2060ES
- IBM Infoprint 2075ES
— IBM Infoprint 2090ES
— IBM Infoprint 2105ES

Infoprint Manager for Windows README 11
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« Infoprint Manager now supports printing the following AFP"" bar codes for
customers with printers that support and applications that can generate:

— QR Code

— Code 93

— EAN 128 BarCode

— Australian Postal BarCode

* The Infoprint Manager SAP Clients install has been enhanced to allow users to
turn graphics content object architecture (GOCA) support on or off on all client
platforms.

¢ The transform subsystem has been enhanced to allow:
— Passing job, document and actual destination attributes to the transform

— The transform to update the job’s job-page-count and pages-completed
attributes.

— The creation of conditional terminating transforms that can be useful when
passing information to other applications.

* Support through the ps2afp transform for both staple and punch support.

This support is limited to PostScript printers like the IBM Infoprint 2060ES and
IBM Infoprint 2075ES that have PostScript drivers that support this function.

Release notes for Version 2.1.0 PTF UR53923 (April 2003)

12

PTF UR53923 (APAR IR50128) contains several enhancements to function, usability,
and reliability. Refer to the “Functional Enhancements” section for more
information. For a summary of the fixes provided with this PTF, refer to the
Service Page of the Infoprint Manager for Windows 2.1 Web site at

http:/ /www.printers.ibm.com/R5PSC.NSF/Web /ipw210ser

To apply this service update, refer to the Infoprint Manager for Windows: Getting
Started manual.

Number of error logs expanded

If you apply PTF U53923, the default number of error logs retained for your
Infoprint Manager server, Notification server, and SAP Callback processes increases
from one to ten. You can increase or decrease the number of error logs that
Infoprint Manager saves, but will need to follow the directions provided in
“Customizing error logs in the Infoprint Manager server” in Infoprint Manager for
Windows: Procedures.

Enhanced performance of Infoprint Manager Server in a
distributed environment

A distributed environment consists of many Infoprint actual destinations for each
print queue. As a general rule, as the number of jobs in a queue or the number of
actual destinations on a queue grows, job throughput can slow. Infoprint Manager
server (pdserver) has been enhanced in PTF UR93523 so that it processes jobs more
quickly in a distributed environment if the jobs have a value for the
actual-destinations-requested job attribute.

Functional enhancements

The following enhancements in function and usability are available with the April
2003 Infoprint Manager for Windows PTF:
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* Hot folder job support no longer requires you to use staging for single
document large files.

* The Infoprint Manager GUI now releases jobs in the order they are displayed.

* You can now submit rip and hold jobs to a PSF printer that uses a transform
object, and the results will be the same as with other rip-and-hold jobs.

* You can now customize Infoprint Manager server error logs to save the number
of backup logs you define for your installation.

Release notes for Version 2.1.0 PTF UR53740 (November 2002)

PTF UR53740 (APAR IR48858) contains several enhancements to function, usability,
and reliability. Refer to the “Functional Enhancements” section for more
information. For a summary of the fixes provided with this PTF, refer to the
Service Page of the Infoprint Manager for Windows 2.1 Website at

http:/ /www.printers.ibm.com/R5PSC.NSF/Web /ipw210ser

To apply this service update, refer to the Infoprint Manager for Windows: Getting
Started manual.

Job contextual menu on Administration and Operations GUIs
may not be fully visible

Due to a problem with the Java'~ implementation tools, there may be cases when
the job contextual menu displays beyond the bottom of the display screen when
selected from the Administration GUI or the Operations GUIL You must manually
move the menu up in order to see the entire display.

Selecting enhanced or standard Infoprint Select

Once you have successfully installed Infoprint Select, you must determine whether
or not you want the enhanced version of the client that is available with PTF
URS53740. If you use the enhanced Select, users can enter job and document
attributes with print jobs if the printer they send the job to is a Select printer. You
may decide not to provide this ability to end users since it requires an
understanding of how to use attributes. For more information on the enhanced
Select and specifying attributes, refer to the Infoprint Manager for Windows: Getting
Started manual.

Note that if you use Infoprint Select in a language other than English, the
enhanced version is not available at this time.

If you want to apply the enhanced Infoprint Select, perform the following action:

Click the Start button on your Windows system and select Programs + Infoprint
Select » Activate attributes dialog.

This action ensures that you can access the new dialog panels that allow you to
specify Infoprint job attributes when submitting a job to the server, as well as
cancelling, holding, and releasing jobs within a queue from the Infoprint Select
client.

Functional enhancements

The following enhancements in function and usability are available with the
November 2002 Infoprint Manager for Windows PTF:
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* Support for the IBM Infoprint 4100 HS2 high quality simplex and IBM Infoprint
4100 HD23/HD4 high quality duplex model printers

* Support for the IBM Infoprint 4345 printer

* Infoprint Manager extends its existing SAP Output Management Support (OMS
Callback) to the Infoprint Manager for Windows platform. This support allows
you to closely integrate an external output management system, like Infoprint
Manager for Windows, with an SAP System. Infoprint Manager for Windows
SAP OMS support allows your SAP users to receive notifications for the jobs
that they have submitted to print or fax. It also provides users to cancel or query
the status of their jobs and to query the status of the device.

* Enhancements to the SAP Client including:

— Sending jobs to multiple Infoprint Manager systems from the same SAP
system

— Switching the Infoprint Manager server that your SAP system is sending
commands to

- Allowing you to define backup Infoprint Manager servers.

Note: For particulars about installing and using this new support, refer to the
latest Infoprint Manager: SAP R/3 Planning and Configuration Guide,
(5544-5902), which is available from the Infoprint Manager for Windows
2.1: Product Library page at
http://www.printers.ibm.com/R5PSC.NSF/Web/ipmrefinfo21.

¢ Enhancements to Infoprint Select including:
— the ability to set and send Infoprint attributes along with the job

— access to print queue and jobs that are located on the Infoprint Manager
server

— faster filtering when configuring an Infoprint Select printer

¢ Enhancements to the Install Shield Multi-Platform packaging software used to
install much of Infoprint Manager

* Functional and usability enhancements in the Administration and Operations
GUIs

— Addition of the job pause (job » pause) action
— Addition of the job resume (job » resume) action

— Addition of the interrupt printing job (Printer » Interrupt Printing Job...)
action

Provides the equivalent function of the following command through the GUI:
pdpause -j destination_name
— Addition of an option not to display retained jobs in the GUIs main window
— Improved GUI response time with large numbers (800-1200) of retained jobs

* Hold processing job support has been enhanced to cancel the job on the printer,
resulting in improved server performance

* New calibration curves for IBM Infoprint 4000 and IBM Infoprint 4100 printers
to support Version 3 Toner

* Support for Korean Output Text Format (OTF) and Advanced Business
Application Programming (ABAP) data streams in the SAP transform

* Support for AFP Font Collection Version 3 through font mapping tables that
apply to all AFCCU and Workgroup printers

* Support for media selection by name rather than bin number with printers that
support this feature
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* Support for the finishing fidelity through the AFP Finishing Fidelity triplet that
provides compatibility with OS/390

* Support for UP3i post-processing through extensions that are available from the
latest level of Page Printer Formatting Aid

* All documentation has been updated and is available from the Infoprint
Manager for Windows Version 2.1 Product Library page at
http://[www.printers.ibm.com/R5PSC.NSF/Web/ipmrefinfo21.

After December 20, 2002, visit the Printing Systems Information Center at
http://publib.boulder.ibm.com/printer/psindex.htm.

While minor changes were made to the man pages, they were not included in
the product build. For the most current information on mvsprsd, pdmod, pdset,
pcl2afpd, pcl2afp, ps2afp, and pdf2afp, refer to the appropriate sections of the
Infoprint Manager: Reference.

Release notes for Version 2.1.0 PTF UR53705 (August 2002)

Note that PTF UR53705 (APAR IR48548) contains no new functional enhancements.
For a summary of the fixes provided with this PTF, refer to the Service Page of the
Infoprint Manager for Windows 2.1 Web site at

http:/ /www.printers.ibm.com/R5PSC.NSF/Web /ipw210ser

To apply this service update, refer to the Infoprint Manager for Windows: Getting
Started manual.

Release notes for the Version 2.1 NLV Refresh

Please note that information on the following topics was removed from this
README because it is now available in the current publications:

Running Infoprint Manager in double-byte languages
Now available in the Infoprint Manager for Windows: Getting Started book in
Chapter 4.

Downloading AFP print drivers from the IBM web site
Now available in the Infoprint Manager for Windows: Getting Started book in
Chapter 20.

Adding forms in the Infoprint Manager Administration GUI

When you add a form in the GUI, it only shows up in the list of available forms
after a job has been run with that specific form. For example, if you associate the
form Letter with Job 1, Letter will not display in the Printer »+ Change Forms or
Job » Change Forms drop-down lists until after Job 1 has completed.

Japanese Common Client CD “Contact Us” title garbled

On the Japanese NLV version of the Common Client CD, the title of the “Contact
Us” page is not translated, and contains garbled English characters. This will be
fixed in a future update of the Common Client CD.

Release notes for Version 2.1

Please note that information on the following topics was removed from this
README because it is now available in the current publications:

Close Infoprint Manager Administration GUI, Operations GUI, and
Management Console before installing any PTF or re-installing Infoprint
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Manager
Now available in the Infoprint Manager for Windows: Getting Started book in
Chapter 4.

Ensure that the Infoprint Manager server and the Administration and
Operations GUI are at the same level
Now available in the Infoprint Manager for Windows: Getting Started book in
Chapter 4.

Power on a destination before creating as an actual destination
Now available in the Infoprint Manager for Windows: Getting Started book in
Chapter 9.

Whenever possible, load print drivers on the server for each client operating
system
Now available in the Infoprint Manager for Windows: Getting Started book in
Chapter 16.

Notification method “exit” cannot run a program that requires a window
Now available in the Infoprint Manager for Windows: Procedures book in
Chapter 7.

Setting up finishing options for the Infoprint 2085 and Infoprint 2105
Now available in the Infoprint Manager for Windows: Procedures book in
Chapter 26.

Verifying configuration with SecureWay Communications

If you use PSF Direct to print from host systems, you must also install IBM
SecureWay® Communications Server for Windows NT® at Version 6.01 with
required APARs JR13453, JR13599, and JR14098 or IBM SecureWay
Communications Server for Windows 2000 at Version 6.1. (Host systems include
MVS"™, VSE, VM, and OS/400®.)

Currently with Version 6.1, there is an error with configuration verification with
SecureWay Communications Server. To correct this error, use the following
procedure:

1. Go to Start » Programs » IBM Communications Server » Configuration
Verification.

2. Go to File » Open... and select the controllername.acg file that you want to
verify, where controllername is the name you gave the configuration file.

3. Click on the Checkmark icon and a message similar to the following is
displayed:
Verifying...
PCS7210E The value NN for keyword
/LOCAL_LU[LU_NAME=PSFDCFLU]/DEFAULT_POOL/ is not valid.
Verify ended with errors.

4. Click on the Pencil icon and locate the line that contains LOCAL_LU= and change
the DEFAULT_POOL=NN to O (zero), where NN is the number reported in the
message in Step 3.

5. Go to File » Exit and click Yes when prompted to save the controllername.acg
file.

6. Reverify the controllername.acg file again by clicking on the Checkmark icon.
The following message is displayed:

Verifying...
Verify complete with no errors.
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Notes:

1. Preliminary testing has been completed with IBM SecureWay Communications
Server, Version 6.1, and Infoprint Manager for Windows. However, the PSF
Direct Network Configuration Guide that is available on our Web site and
publications CD-ROM was developed and tested using Version 6.01. Minor
differences exist between the two versions, and these differences will be tested
and documented in the future.

2. If you need to uninstall IBM SecureWay Communications Server, you should
uninstall Personal Communications first. However, if you have installed APAR
JR14481, the uninstall process informs you of this situation.

Setting the TCP KEEPALIVE frequencies (for customers using
Download for OS/390 or DPF)

Because network objects, such as printers, are sometimes terminated abruptly (for
example, powered off), it is advisable to use a periodic poll that enables TCP to
discover when a connection is no longer usable. This periodic polling is called the
KEEPALIVE frequency.

The frequency of these KEEPALIVE transmissions is determined by system-wide
TCP/IP configuration parameters in the host(s). You should set the KEEPALIVE
interval, as described in the instructions for your particular type of host, to be
much smaller (for example, four minutes), to maintain the network connection.
This allows the system to detect if a printer has been powered off or is no longer
accessible to the network.

Manually running fontmap.cmd on new Windows systems

During configuration, a file called fonts.map is created. This file is used by the
PostScript and PDF transforms. In cases where the install of Infoprint Manager is
done on a new Windows system, it is possible for this file to be created with a size
of 0 bytes. If this happens, the transforms will fail. To solve this problem, from a
Command Prompt navigate to the install_path\PS folder and enter this command
to run the font command script: fontmap.cmd.

While this script is running, it is checking for the fonts installed on your system,
and you may see messages on the screen indicating fonts that are not installed.
These are not error messages, and you can ignore them.

How to access Font Downloader Feature user’s guide

On the Infoprint Manager for Windows Font Downloader Feature CD-ROM, access
the User’s Guide by viewing the CD-ROM contents and clicking on
“usersguide.pdf”. You must have Adobe Acrobat Reader to view this file.

Limitations, restrictions, and pre-reqs

Install Generic Windows Driver before setting up Passthrough
destinations

Before configuring any Passthrough destinations, you must install the Generic/Text
Only Driver from your Windows CD.
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Windows Gateway Printer considerations for mixed Windows
NT/2000 client and server

If a Windows 2000 machine is being used as an Infoprint Manager client and a
Windows NT 4.0 machine is being used as an Infoprint Manager Server, be aware
of the following situation:

A Windows Gateway Printer is created on the Windows NT server machine using
Windows NT AFP drivers. That Windows Gateway Printer is then added to the
Windows 2000 Client machine using the Add Printer wizard. Behind the scenes,
Windows tries to load the Windows NT AFP drivers onto the Windows 2000
machine and the Windows 2000 machine crashes. Do not do this.

Patience when launching the Operations or Administration GUI
When you install the Infoprint Manager Server, or install the GUIs from the client
CD, one icon will appear for the Operations GUI and one for the Administration
GUL When you double click either of these desktop icons, a “splash” screen will
appear, and there may be a delay before the GUI screen appears. Do not double
click the icon again as this will launch a second instance of the GUIL

JRE required to uninstall GUIs

The Infoprint Manager for Windows: Getting Started manual mentions in several
places the process for uninstalling the JRE or Infoprint Manager Administrator and
Operator GUISs. If you uninstall the JRE first, the GUIs cannot be uninstalled since
the uninstall process for the GUIs is a Java uninstall process that requires a version
of JRE to run. If you want to uninstall both the JRE and the GUIs, make sure you
uninstall the GUISs first.

Infoprint Select and the Infoprint Generic Driver

When a user installs Infoprint Select on a client machine from the Common Clients
CD-ROM, the Infoprint Generic Driver is also installed on their Windows machine.
This Infoprint Generic PostScript Driver can be used when the user creates a Select
printer on their client machine. When a job is sent to the Select printer that uses
this driver, the driver sets some job attributes that allow the job to be printed on a
PSF actual destination only. The Infoprint Generic Driver should be used only if
the Select printer is configured to point to a PSF destination. An alternate driver
for the Select printer should be used if the Select printer is configured to point to
another type of printer.

Installing and uninstalling requires administrative privilege

You must have Administrative Privilege to install or uninstall IBM Infoprint
Manager for Windows. If you try to uninstall the product without administrative
privilege, the following message is issued:

Setup Installation Error: Setup has detected Uninstallshield is in use,
please close Uninstallshield and restart setup (Error 432).

A similar message is issued at install if you do not have administrative privilege.

Ensure that you have Administrative Privilege before attempting to install or
uninstall IBM Infoprint Manager for Windows.

Remember to reboot at end of installation

After you have installed IBM Infoprint Manager for Windows, the installation
program asks if you want to reboot your system. The default answer to this
question is Yes because Infoprint Manager will not function properly until the
system is rebooted. When you click OK or press Enter, your system reboots.
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Stop and restart server after prolonged server activity

Due to known limitations involving prolonged server activity, it is strongly
recommended that the Infoprint Manager Server be stopped and restarted every
seven (7) days to avoid potential problems that could disrupt server processing.

To stop and restart the server:

1. Disable all actual destinations with the Infoprint Administration or Operations
graphical user GUIL

Wait for all currently printing jobs to finish.
Stop the Infoprint Manager Server through the Management Console.

Restart the Infoprint Manager Server through the Management Console.

Sl A

Re-enable all actual destinations through the Administration or Operations
GUL

Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property rights may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785 U.S.A.

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) described in this publication at any time without
notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
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sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3—-chome, Minato-ku
Tokyo 106, Japan

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Printing Systems Division
Department H7FE Building 003G
Information Development

PO Box 1900

Boulder CO 80301-9191 USA

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee. The licensed program described in this
document and all licensed material available for it are provided by IBM under
terms of the IBM Customer Agreement, IBM International Program License
Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurement may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information is for planning purposes only. The information herein is subject to
change before the products described become available.

For online versions of this book, we authorize you to:
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* Copy, modify, and print the documentation contained on the media, for use
within your enterprise, provided you reproduce the copyright notice, all

warning statements, and other required statements on each copy or partial copy.
Transfer the original unaltered copy of the documentation when you transfer the

You are responsible for payment of any taxes, including personal property taxes,

related IBM product (which may be either machines you own, or programs, if

the program’s license terms permit a transfer). You must, at the same time,
destroy all other copies of the documentation.

resulting from this authorization.

Your failure to comply with the terms above terminates this authorization. Upon

termination, you must destroy your machine readable documentation.

Trademarks

The following are trademarks or registered trademarks of International Business

Machines Corporation:

Advanced Function Printing
AFP

AIX

AS/400

eNetwork

IBM

Infoprint

Intelligent Printer Data Stream
IPDS

Micro Channel

MVS

0Ss/2

0S/390

0S/400

Print Services Facility

S/390

System/370

The following are trademarks of other companies:
Java and all Java-based trademarks and logos are trademarks or registered

trademarks of Sun Microsystems, Inc. in the United States, other countries, or

both.

Microsoft, MS-DOS, Windows, Windows NT, Windows 2000, Windows ME,
Microsoft Visual Basic, Microsoft Visual C++, and the Windows logo are

trademarks of Microsoft Corporation in the United States, other countries, or

both.

Pentium is a registered trademark of Intel Corporation in the United States,

other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and

other countries.

Other company, product, and service names may be trademarks or service marks
of others.

Infoprint Manager for Windows README

21



	 
	IBM Infoprint Manager for Windows Version 2.1.0 README
	General Release Notes for Infoprint Manager for Windows
	Backing up the UserInit file for the PostScript transform program
	Possible issues when completing Infoprint Manager for Windows Server 2.1.0 install
	Accessing the Publications CD-ROM
	Viewing the Publications CD-ROM

	Release Notes for Version 2.1.0 PTF UR54364 (July 2004)
	Windows error messages when installing Infoprint Manager
	MVS download receivers cannot exceed 50
	New lpdmap.txt file included with PTF UR54364
	Viewing national characters in a DOS window for French, German, Italian, or Spanish servers
	Clarification about accounting exits
	Accounting reports provide structured information

	Using the 'no resident' version of the sample grid files
	Infoprint Manager documentation updates
	Functional enhancements
	Windows Server 2003 Standard operating system supported
	Support for new printers with Infoprint Manager
	Support formsize specification
	The sap2afp transform includes Simplified Chinese and Traditional Chinese language support and SAPGOF data generated from SAP SmartForms support
	Line data using OpenType fonts now supports using the Byte Order Mark (BOM) and little endian data
	Print-on-Demand feature now available with Infoprint Manager for Windows
	Sample MVS Download exit program enhanced


	Release Notes for Version 2.1.0 PTF UR54088 (December 2003)
	Infoprint Manager documentation updates
	Functional enhancements

	Release notes for Version 2.1.0 PTF UR53923 (April 2003)
	Number of error logs expanded
	Enhanced performance of Infoprint Manager Server in a distributed environment
	Functional enhancements

	Release notes for Version 2.1.0 PTF UR53740 (November 2002)
	Job contextual menu on Administration and Operations GUIs may not be fully visible
	Selecting enhanced or standard Infoprint Select
	Functional enhancements

	Release notes for Version 2.1.0 PTF UR53705 (August 2002)
	Release notes for the Version 2.1 NLV Refresh
	Adding forms in the Infoprint Manager Administration GUI
	Japanese Common Client CD “Contact Us” title garbled

	Release notes for Version 2.1
	Verifying configuration with SecureWay Communications Server
	Setting the TCP KEEPALIVE frequencies (for customers using Download for OS/390 or DPF)
	Manually running fontmap.cmd on new Windows systems
	How to access Font Downloader Feature user's guide
	Limitations, restrictions, and pre-reqs
	Install Generic Windows Driver before setting up Passthrough destinations
	Windows Gateway Printer considerations for mixed Windows NT/2000 client and server
	Patience when launching the Operations or Administration GUI
	JRE required to uninstall GUIs
	Infoprint Select and the Infoprint Generic Driver
	Installing and uninstalling requires administrative privilege
	Remember to reboot at end of installation
	Stop and restart server after prolonged server activity


	Notices
	Trademarks



